Release Notes
RobotStudio
6.07.01
Revision: -
The information in this manual is subject to change without notice and should not be construed as a commitment by ABB. ABB assumes no responsibility for any errors that may appear in this manual.

Except as may be expressly stated anywhere in this manual, nothing herein shall be construed as any kind of guarantee or warranty by ABB for losses, damages to persons or property, fitness for a specific purpose or the like.

In no event shall ABB be liable for incidental or consequential damages arising from use of this manual and products described herein.

This manual and parts thereof must not be reproduced or copied without ABB's written permission.

Additional copies of this manual may be obtained from ABB.

The original language for this publication is English. Any other languages that are supplied have been translated from English.

© Copyright 2008 - 2018 ABB All rights reserved.
ABB AB
Robotics Products
SE-721 68 Västerås
Sweden
# Table of Contents

## 1 Release Information

- 1.1 General 5
- 1.2 System recommendation 5
- 1.3 Simulation Models 7

## 2 What’s new in RobotStudio 6.07

- 2.1 New features 9
- 2.2 Changes related to Integrated Vision 11
- 2.3 Improvements 12

## 3 Late Breaking Information

## 4 Corrections

- 4.1 Corrections made in 6.07.01 16
- 4.2 Corrections made in 6.07 16

## 5 Known Limitations

- 5.1 Visual SafeMove 19
- 5.2 Online
  - 5.2.1 Online – Paint 19
  - 5.2.2 Online – Integrated Vision 20
- 5.3 Offline
  - 5.3.1 Conveyor Tracking 22
  - 5.3.2 Station Viewer 24
  - 5.3.3 MultiMove 25
  - 5.3.4 External Axis 25
  - 5.3.5 Network Drives and UNC Paths 26
  - 5.3.6 RAPID 27
  - 5.3.7 Paint 27
  - 5.3.8 Graphics and Geometry 28
- 5.4 ScreenMaker Limitations 28

## 6 RobotWare Compatibility

- 6.1 General 30
6.2 RobotWare 5.05 and 5.06 Compatibility 30
6.3 RobotWare 5.07 Compatibility 30
6.4 RobotWare 5.08 Compatibility 30
6.5 RobotWare 5.10 Compatibility 30
6.6 RobotWare 5.11 Compatibility 30
6.7 RobotWare 5.12 Compatibility 31
6.8 RobotWare 5.13 Compatibility 31
6.9 RobotWare 5.15 Compatibility 32
6.10 RobotWare 6 Compatibility 32
6.11 General Compatibility Limitations 32
6.12 ScreenMaker Compatibility 32
6.13 Support for future RobotWare versions 33
1 Release Information

1.1 General

Release Name
The release name is RobotStudio 6.07.01 and the build number is 6.07.7963.1011. This is a quality release with only minor corrections and updates and no new features.

Release Date
The release date is June 19th, 2018.

Demo stations
The following demo stations are included in this version.

- Demo AW Station
- Demo Solar Simulation
- Demo Exhaust Pipe
- Demo FlexLoader

They are stored in the Pack & Go format (.rspag) and can be opened with the command Unpack & Work on the Share section of the RobotStudio menu.

ScreenMaker Demo Station and Project
There is a demo station and associated ScreenMaker project available.

- SCM_ExampleProject (ScreenMaker Project)
- SCM_ExampleStation (RobotStudio station)

These files are found in the ‘Addins/ScreenMaker/Samples’ folder under the RobotStudio installation folder.

Tutorials
Tutorials are available at the RobotStudio product pages at http://www.abb.com/roboticssoftware

Documentation
User documentation for RobotStudio is available from the Help button ( ≡ ) in the upper-right corner of RobotStudio.

The complete documentation in PDF for RobotWare including RobotStudio is available from the Help menu in RobotStudio for Premium users. Internet connection is required.

1.2 System recommendation

Recommended Software

<table>
<thead>
<tr>
<th>Operating System</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Windows 7 SP1</td>
<td>32-bit edition</td>
</tr>
<tr>
<td>Microsoft Windows 7 SP1 (recommended)</td>
<td>64-bit edition</td>
</tr>
<tr>
<td>Microsoft Windows 10 (recommended)</td>
<td>64-bit edition</td>
</tr>
</tbody>
</table>

It is recommended to run Windows Update to get the latest updates to Windows prior to installing and running RobotStudio. This applies to any of the operating systems above.
Recommended Hardware

<table>
<thead>
<tr>
<th>Item</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>2.0 GHz or faster processor, multiple cores recommended</td>
</tr>
<tr>
<td>Memory</td>
<td>3 GB if running Windows 32-bit</td>
</tr>
<tr>
<td></td>
<td>8 GB or more if running Windows 64-bit (recommended)</td>
</tr>
<tr>
<td>Disk</td>
<td>10+ GB free space, solid state drive (SSD)</td>
</tr>
<tr>
<td>Graphics card¹</td>
<td>High-performance, DirectX 11 compatible, gaming graphics card from any of the leading vendors. For the Advanced lightning mode Direct3D feature level 10_1 or higher is required.</td>
</tr>
<tr>
<td>Screen resolution</td>
<td>1920 x 1080 pixels or higher is recommended</td>
</tr>
<tr>
<td>DPI</td>
<td>Normal size (100% / 96 dpi) up to Large size (150% / 144 dpi) Only Normal size supported for Integrated Vision.</td>
</tr>
<tr>
<td>Mouse</td>
<td>Three-button mouse</td>
</tr>
<tr>
<td>3D Mouse [optional]</td>
<td>Any 3D mouse from 3DConnexion, see <a href="http://www.3dconnexion.com">http://www.3dconnexion.com</a>.</td>
</tr>
</tbody>
</table>

¹ A note on graphics cards and PC hardware. RobotStudio will not benefit from the additional features of so-called 'Professional' or 'Workstation' graphics cards. The price level of these are at a much higher range than gaming graphics cards with comparable performance. High-end gaming PCs are very suitable for offline programming with RobotStudio. Such a PC will provide good performance for a limited budget.

Note

The Windows Firewall will try to block features necessary to run RobotStudio. Make sure to unblock these features when asked (Industrial Robot Discovery Server, RobotStudio AppFramework module, Virtual RobotController (all published by ABB)). The blocking state of a certain program can be viewed and changed at Start/Control Panel/WINDOWS Security Center/Windows Firewall. Read more on http://www.microsoft.com.
### 1.3 Simulation Models

**Robot Libraries**

<table>
<thead>
<tr>
<th>IRB Variant</th>
<th>IRB Variant</th>
</tr>
</thead>
<tbody>
<tr>
<td>120 3kg/0.58m</td>
<td>4400S 30kg</td>
</tr>
<tr>
<td>120T 3kg/0.58m</td>
<td>4450S 30kg</td>
</tr>
<tr>
<td>1200 5kg/0.9m BTM (-/FGL/+/FPL)</td>
<td>4600 20kg/2.5m</td>
</tr>
<tr>
<td>1200 5kg/0.9m STD (-/FGL/+/FPL)</td>
<td>4600 20kg/2.5m Type C</td>
</tr>
<tr>
<td>1200 5kg/0.7m BTM (-/FGL/+/FPL)</td>
<td>4600 45kg/2.05m Type C</td>
</tr>
<tr>
<td>1200 5kg/0.7m STD (-/FGL/+/FPL)</td>
<td>4600 60kg/2.05m</td>
</tr>
<tr>
<td>140 5kg/0.8m Type A/B</td>
<td>4600 60kg/2.05m Type C</td>
</tr>
<tr>
<td>140 5kg/0.8m Type C</td>
<td>4600 40kg/2.55m</td>
</tr>
<tr>
<td>140T 5kg/0.8m Type C</td>
<td>4600 40kg/2.55m Type C</td>
</tr>
<tr>
<td>1400 Type A/B</td>
<td>4600 45kg/2.05m</td>
</tr>
<tr>
<td>1400H Type A/B</td>
<td>6400R 200kg/2.5m</td>
</tr>
<tr>
<td>1410</td>
<td>6400R 200kg/2.5m</td>
</tr>
<tr>
<td>1520ID</td>
<td>6400R 120kg/2.5m</td>
</tr>
<tr>
<td>1600 5kg/1.2m</td>
<td>6400R 150kg/2.8m</td>
</tr>
<tr>
<td>1600 5kg/1.2m Type A</td>
<td>6400R 150kg/2.8m</td>
</tr>
<tr>
<td>1600 5kg/1.45m</td>
<td>6400R 100kg/3.0m</td>
</tr>
<tr>
<td>1600 5kg/1.45m Type A</td>
<td>640</td>
</tr>
<tr>
<td>1600 6kg/1.2m</td>
<td>660 180kg/3.15m</td>
</tr>
<tr>
<td>1600 6kg/1.45m</td>
<td>660 250kg/3.15m</td>
</tr>
<tr>
<td>1600 7kg/1.2m</td>
<td>660 175kg/2.55m</td>
</tr>
<tr>
<td>1600 7kg/1.2m Type A</td>
<td>660 175kg/2.55m</td>
</tr>
<tr>
<td>1600 7kg/1.45m</td>
<td>660 225kg/2.55m</td>
</tr>
<tr>
<td>1600 7kg/1.45m Type A</td>
<td>660ID 185kg/2.55m</td>
</tr>
<tr>
<td>1600 8kg/1.2m</td>
<td>660 150kg/2.2m</td>
</tr>
<tr>
<td>1600 8kg/1.45m</td>
<td>660LX 155/1.9m</td>
</tr>
<tr>
<td>1600 10kg/1.2m</td>
<td>660 130kg/3.3m</td>
</tr>
<tr>
<td>1600 10kg/1.45m</td>
<td>660 180kg/2.55m</td>
</tr>
<tr>
<td>1600ID 4kg/1.5m</td>
<td>660 185kg/2.8m</td>
</tr>
<tr>
<td>1660ID 4kg/1.55m</td>
<td>660 205kg/2.75m</td>
</tr>
<tr>
<td>1660ID 6kg/1.55m</td>
<td>660 235kg/2.55m</td>
</tr>
<tr>
<td>2400 10kg</td>
<td>660ID 170kg/2.75m</td>
</tr>
<tr>
<td>2400 18kg</td>
<td>660ID 200kg/2.55m</td>
</tr>
<tr>
<td>2400L</td>
<td>660 150kg/2.55m DP6</td>
</tr>
<tr>
<td>2600 12kg/1.65m</td>
<td>660 165kg/2.8m DP6</td>
</tr>
<tr>
<td>2600 20kg/1.65m</td>
<td>660 185kg/2.75m DP6</td>
</tr>
<tr>
<td>2600 12kg/1.85m</td>
<td>660 200kg/2.55m DP6</td>
</tr>
<tr>
<td>2600ID 9kg/2.0m</td>
<td>6650 125kg/3.2m</td>
</tr>
<tr>
<td>2600ID 15kg/1.85m</td>
<td>6650 200kg/2.75m</td>
</tr>
<tr>
<td>2600ID 15kg/1.85m</td>
<td>6650ID 170kg/2.75m</td>
</tr>
<tr>
<td>2600ID 15kg/1.85m</td>
<td>6650ID 170kg/2.75m</td>
</tr>
<tr>
<td>2600ID 15kg/1.85m</td>
<td>6650ID 170kg/2.75m</td>
</tr>
<tr>
<td>340</td>
<td>6650S 125kg/3.5m</td>
</tr>
<tr>
<td>360 1kg/1130 Std No axis 4</td>
<td>6650S 200kg/3.0m</td>
</tr>
<tr>
<td>360 1kg/1130 Wash-down No axis 4</td>
<td>6650S 200kg/3.0m MH6</td>
</tr>
<tr>
<td>360 1kg/1130 Standard</td>
<td>6650S 100kg/3.5m MH6</td>
</tr>
<tr>
<td>360 1kg/1130 Stainless</td>
<td>6650S 190kg/3.0m MH6</td>
</tr>
<tr>
<td>360 1kg/800 Std No axis 4</td>
<td>6650S 100kg/3.5m SW6</td>
</tr>
<tr>
<td>360 1kg/800 Wash-down No axis 4</td>
<td>6650S 190kg/3.0m SW6</td>
</tr>
<tr>
<td>360 1kg/800 Standard</td>
<td>6650S 125kg/3.5m MH3</td>
</tr>
<tr>
<td>360 1kg/800 Stainless</td>
<td>6650S 200kg/3.0m MH3</td>
</tr>
<tr>
<td>360 1kg/800 Wash-down</td>
<td>6650S 90kg/3.9m MH3</td>
</tr>
<tr>
<td>360 1kg/1130 Std No axis 4</td>
<td>8700 145 kg/3.2m MH</td>
</tr>
<tr>
<td>360 1kg/1600 Standard</td>
<td>6700 150 kg/3.2m MH</td>
</tr>
<tr>
<td>360 1kg/1600 Standard</td>
<td>6700 150 kg/3.2m MH</td>
</tr>
<tr>
<td>360 8kg/1130 Standard</td>
<td>6700 155 kg/3.05m MH</td>
</tr>
<tr>
<td>4400 45kg</td>
<td>6700 155 kg/3.05m SW</td>
</tr>
<tr>
<td>4400 60kg</td>
<td>6700 175 kg/3.05m MH3</td>
</tr>
<tr>
<td>4400L 10kg</td>
<td>6700 175 kg/3.05m</td>
</tr>
<tr>
<td>4400L 30kg</td>
<td>6700 204 kg/2.8m MH</td>
</tr>
</tbody>
</table>

**Note**

All simulation models in the table are installed with RobotStudio, but only the robots in the current product range are displayed in the ABB Library gallery. To import any other robot you need to browse to the file on disk.

© Copyright 2018 ABB All rights reserved
Robot Libraries Paint

<table>
<thead>
<tr>
<th>Variant</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>52 short vertical arm</td>
<td>52 std vertical arm</td>
<td>540-12 std arm</td>
</tr>
<tr>
<td>580-12 std arm</td>
<td>580-12 short arm</td>
<td>5300-12 left</td>
</tr>
<tr>
<td>5300-12 right</td>
<td>5320-1500</td>
<td>5320-2000</td>
</tr>
<tr>
<td>5350/01 Type Left</td>
<td>5350/01 Type Right</td>
<td>5350/02 Type Left Side Left</td>
</tr>
<tr>
<td>5350/02 Type Left Side Right</td>
<td>5350/02 Type Right Side Left</td>
<td>5350/02 Type Right Side Right</td>
</tr>
<tr>
<td>5400-12 std arm</td>
<td>5400-13 std arm</td>
<td>5400-14 std arm</td>
</tr>
<tr>
<td>5400-22 process arm</td>
<td>5400-23 process arm</td>
<td>5400-24 process arm</td>
</tr>
<tr>
<td>5400-12 std arm axis 2 +60 deg</td>
<td>5400-13 std arm axis 2 +60 deg</td>
<td>5400-14 std arm axis 2 +60 deg</td>
</tr>
<tr>
<td>5500 35A b_00 / b_80</td>
<td>5500 35B b_00 / b_80</td>
<td>5500 ProArm 35A b_00 / b_80</td>
</tr>
<tr>
<td>5500 ProArm 35B b_00 / b_80</td>
<td>^5510</td>
<td></td>
</tr>
</tbody>
</table>

Track Libraries

RobotStudio is distributed with the following track types that are available in the Track folder of the ABB Library.

<table>
<thead>
<tr>
<th>Track family</th>
<th>Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>IRBT2005</td>
<td>2 m to 21 m</td>
</tr>
<tr>
<td>IRBT4003</td>
<td>1.7 m to 10.7 m</td>
</tr>
<tr>
<td>IRBT4004</td>
<td>1.9 m to 19.9 m</td>
</tr>
<tr>
<td>IRBT6003</td>
<td>1.7 m to 10.7 m</td>
</tr>
<tr>
<td>IRBT6004</td>
<td>1.7 m to 19.7 m</td>
</tr>
<tr>
<td>IRBT7003</td>
<td>1.7 m to 10.7 m</td>
</tr>
<tr>
<td>IRBT7004</td>
<td>1.7 m to 19.7 m</td>
</tr>
<tr>
<td>RTT_Bobin</td>
<td>1.7 m to 11.7 m</td>
</tr>
<tr>
<td>RTT_Marathon</td>
<td>1.7 m to 11.7 m</td>
</tr>
<tr>
<td>Paint Rails</td>
<td>2 m to 20 m</td>
</tr>
<tr>
<td>left and right versions</td>
<td></td>
</tr>
<tr>
<td>IRBS350 Rail</td>
<td>3 m to 10 m</td>
</tr>
<tr>
<td>left and right versions</td>
<td></td>
</tr>
<tr>
<td>Elevated Rail</td>
<td>3 m to 10 m</td>
</tr>
<tr>
<td>left and right versions</td>
<td></td>
</tr>
</tbody>
</table>
2 What’s new in RobotStudio 6.07

Overview

This section describes the new features of RobotStudio 6.07.

2.1 New features

Virtual Reality Lead Through Programming

Virtual Reality allows robot programs to be created in an intuitive way by guiding the robot through the process and simultaneously recording the motion. Lead-through programming efficiently lowers the threshold and allows non-robot experts to do the motion programming as hands-on lead-through programming is not possible in reality due to various limitations such as safety, availability of equipment, work environment, and ergonomics. VR Lead-through programming guarantees reachability since the robot manipulator itself is used to teach the path. The VR functionality is built into RobotStudio and is enabled for Premium users.

Virtual Reality Meeting

In a Virtual Reality Meeting, several participants can share the same virtual room from multiple locations. You can see avatars of each other, talk, draw, and make annotations in a live RobotStudio simulation. Virtual Reality provides an accurate perception of dimensions, ergonomics, and accessibility for cleaning and servicing of equipment. The VR Meeting function helps in design reviews and to correct errors at an early stage. This results in significantly shorter installation and start-up phase.
Graphical Path Editor for real controllers

The paths of a real robot can be viewed and edited graphically without the need of a virtual controller or running a simulation. You can load a workpiece to see the path in relation to the part geometry. By enabling the tool visualization, you can easily see the target orientation. The property window allows you to tune multiple robot targets in a single operation.

Generic motion instructions, e.g. MyMoveL, can be edited by adding the corresponding instruction template files to the folder

<RobotStudio user document location>\InstructionTemplates.

For a default installation of RobotStudio on Windows the default the folder is

C:\Users\<user name>\Documents\RobotStudio\InstructionTemplates,

where <user name> shall be replaced by the user name of the currently logged in Windows user.

The RobotStudio user document location can be set in the RobotStudio Options, see below

To create an instruction template file for your custom motion instructions proceed as follows.

1. Connect to a controller
2. Press the Go Offline button to create a virtual replica of your real controller.
3. Working with the virtual controller, create instruction templates and save to file. This is done with the Instruction Template Manager.
4. Copy the file to the following location:
   C:\Users\<user name>\Documents\RobotStudio\InstructionTemplates

5. Restart RS

6. Connect to the real controller again.

7. Open the RAPID path editor for a selected RAPID routine that contains the path you want to edit.

Done! Now you should be able to see a graphical representation of your path including your custom motion instructions.

Note that the instruction template file can be distributed to anyone who will use the path editor with the customized move instructions.

I/O Configurator

The I/O Configurator required for configuration of PROFINET, PROFISAFE and the CI-502 module is integrated with RobotStudio 6.07. The I/O Configurator can be opened from the Configuration menu of the Controller tab.

Configuration of new module for conveyor tracking

Functionality is added to setup and maintain the Ethernet based conveyor tracking unit DSQC2000.

2.2 Changes related to Integrated Vision

Enable/Disable tools (RobotWare)

The controller will now discard all “Output to RAPID data” for a specific “Part” if the tool that is linked to the part is disabled, see screen shot below.

Motivation: If a user disables a tool during runtime they often assume that data from these tools are not included when they do a CamGetResult.

You can enable/disable a tool in runtime by using the RAPID instruction
CamSetParameter(camera, “toolName”, boolValue );

![Screenshot of RAPID path editor](image)

```
CamSetParameter mycamera, "Pattern_1.Tool_Enabled" \Bc1Val:=TRUE;
CamSetParameter mycamera, "Pattern_2.Tool_Enabled" \Bc1Val:=FALSE;
```

PatMax 1-10 with Advanced Sorting (RobotStudio)

A new localization tool have been added to IV in RobotStudio.

With this new tool you can use a normal PatMax but with another set of sorting instructions in the EasyBuilder interface.
The different sorting instructions included are X, Y, GridX, GridY, Angle, Angular Distance and Distance.

Note: These sorting functions are based on the image coordinate system and could be somewhat confusing, so please lookup “SortPatterns” in the online manual for further information.

Changes made to the camera emulator support (PDD6353)

The Cognex camera emulator doesn’t allow us to “acquire an image” so we have now added an Elog message to warn the user that “CamReqImage” is not supported when running against a camera emulator. On a real controller the warning is a stopping error and on a virtual controller it’s just an eLog warning.

(You could still verify your vision job file by using the camera emulator in RobotStudio and you can still verify your RAPID program by manually create a Part and map constant values in X,Y,..)

2.3 Improvements

Improvements of the RAPID Data Editor

RAPID Data can be filtered by its use in a selected routine. Also, it can be sorted in order of usage. This is particularly useful when editing robtargets.

Selection of RobotWare Add-Ins

When opening a Pack&Go file that contains a virtual controller system that uses a RobotWare add-in, it is possible to select which version that shall be used when unpacking the system if several compatible versions are available.

This also applies to the functions Go Offline and Create system from backup.
Possibility to disable “Follow Program Pointer” in the RAPID Editor

The default setting for the function “Follow Program Pointer” of the RAPID Editor can be set in the RobotStudio Options.

New paint robot IRB 5510

There is a new paint robot in the 5500-family, IRB 5510

New bases for IRB 5500

A new base for floor mounting of the IRB 5500 is available in RobotStudio 6.07.

There is also an alternative base for rail mounting of the IRB 5500.
Automatic synchronization of RAPID

There is an alternative Simulation Play button called “Sync and Play” that will synchronize changes in the station to RAPID before starting the simulation, thus reducing the need for the separate sync step.

Upgrade for firmware of Local I/O

The local I/O units that can ordered as an option to the robot controller has a firmware that can be upgraded with RobotStudio 6.07.

Jobs – controller name and system name added to report

The system name and the controller name can be left blank in the Device List used for a Job. If that is the case, RobotStudio will query the controller and populate these columns in the generated report. This is new in RobotStudio 6.07.

If the system name and controller name is added to the Device List it will be used to validate them. If they do not match, an error will be reported.

Smart Components: Manage I/O Connections has been discontinued

The Smart Component design tool “Manage I/O Connections” has been discontinued. The same tasks can be carried out in the Design View.

Smart Components: Conversion components automatically removed

Since RobotStudio 6.06 it is no longer required to explicitly convert between properties and signal by going through the Converter component, e.g. bool <-> digital signals, real numbers <-> analogue signals, integers <-> group signals

In RobotStudio 6.07, station logic including a Converter component will be removed from the station if no longer required when a station is opened.

Also, it is possible to connect different types if the value can be converted, e.g. double <-> int <-> bool.
3 Late Breaking Information

Overview

This section describes changes and additions done after the Operating Manual was finalized.

*Updates to CAD format versions*

RobotStudio 6.07.01 includes an updated CAD converter that supports the latest versions. (The table below lists all formats and versions supported by RobotStudio for completeness even though not all of them have been updated for 6.07.01).

<table>
<thead>
<tr>
<th>Format</th>
<th>File extensions</th>
<th>Option required</th>
</tr>
</thead>
<tbody>
<tr>
<td>.3DStudio</td>
<td>.3ds</td>
<td>-</td>
</tr>
<tr>
<td>ACIS, reads versions R1 - 2017 1.0, writes versions R18 - 2018 1.0</td>
<td>.sat, .sab, .asat, .asab</td>
<td>-</td>
</tr>
<tr>
<td>CATIA V4, reads versions 4.1.9 to 4.2.4</td>
<td>.model, .exp, .session</td>
<td>CATIA V4</td>
</tr>
<tr>
<td>COLLADA 1.4.1</td>
<td>.dae</td>
<td>-</td>
</tr>
<tr>
<td>DirectX writes 2.0</td>
<td>.x</td>
<td>-</td>
</tr>
<tr>
<td>DXF/DWG, reads versions 2.5 - 2018</td>
<td>.dxf, .dwg</td>
<td>AutoCAD</td>
</tr>
<tr>
<td>FBX writes version 7.5</td>
<td>.fbx</td>
<td>-</td>
</tr>
<tr>
<td>IGES, reads up to version 5.3, writes version 5.3</td>
<td>.igs, .iges</td>
<td>IGES</td>
</tr>
<tr>
<td>Inventor, reads V6 – 2018’</td>
<td>.ipt, .iam</td>
<td>Inventor</td>
</tr>
<tr>
<td>JT, reads versions 8.x, 9.x and 10.x’</td>
<td>.jt</td>
<td>JT</td>
</tr>
<tr>
<td>LDraw, reads version 1.0.2</td>
<td>.ldr, .ldraw, .mpd</td>
<td>-</td>
</tr>
<tr>
<td>NX, reads versions NX 1 – NX 12’</td>
<td>.prt</td>
<td>NX</td>
</tr>
<tr>
<td>OBJ</td>
<td>.obj</td>
<td>-</td>
</tr>
<tr>
<td>Parasolid, reads versions 9.0.* – 30.0.*</td>
<td>.x_t, .xmt_txt, .x_b, .xmt_bin</td>
<td>Parasolid</td>
</tr>
<tr>
<td>Pro/E / Creo, reads versions 16 – Creo 4.0’</td>
<td>.prt, .prt.<em>, .asm, .asm.</em></td>
<td>Pro/ENGINEER</td>
</tr>
<tr>
<td>Solid Edge, reads versions V18 – ST10’</td>
<td>.par, .asm, .psm</td>
<td>SolidEdge</td>
</tr>
<tr>
<td>SolidWorks, reads versions 2003 – 2018</td>
<td>.sldprt, .sldasm</td>
<td>SolidWorks</td>
</tr>
<tr>
<td>STEP, reads versions AP203, AP214, AP242, writes version AP214</td>
<td>stp, step, p21</td>
<td>STEP</td>
</tr>
<tr>
<td>STL</td>
<td>.stl</td>
<td>-</td>
</tr>
<tr>
<td>VDA-FS, reads 1.0 and 2.0, writes 2.0’</td>
<td>vda, vdafs</td>
<td>VDA-FS</td>
</tr>
<tr>
<td>VRML, reads VRML2 (VRML1 not supported)</td>
<td>wrf, vrml, vrml2</td>
<td>-</td>
</tr>
</tbody>
</table>

* Supported only in the 64-bit version of RobotStudio.

The RAPID Profiler has been removed.

The RAPID Profiler has been removed from RobotStudio.
4 Corrections

Overview

This section lists the corrections made.

4.1 Corrections made in 6.07.01

<table>
<thead>
<tr>
<th>ID</th>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>9626</td>
<td>Signal analyzer Online failed for some real controllers</td>
</tr>
<tr>
<td>9811</td>
<td>The Signal Analyzer failed when the internal system ID of the robot controller had lower-case characters instead of upper-case characters. This has been fixed so that RobotStudio ignores the casing for the internal system ID.</td>
</tr>
<tr>
<td>10367</td>
<td>Visual SafeMove: The protect checksum changed for certain configurations.</td>
</tr>
<tr>
<td></td>
<td>A regression in RobotStudio 6.07 caused the protected checksum to change for configurations with nested combinatorial logic (CL). The reason was the generation of internal names of the intermediate gate connections. This bug did not affect configurations with non-nested CL logic.</td>
</tr>
<tr>
<td>10433</td>
<td>Silent install of RobotStudio failed on Windows 10</td>
</tr>
<tr>
<td></td>
<td>When installing RobotStudio silently from the command prompt using the syntax setup.exe /s /v&quot;/qb ADDLOCAL=ALL LICENSE_SERVER=hostname&quot;</td>
</tr>
<tr>
<td></td>
<td>Then RobotStudio incorrectly reported about a missing prerequisite and the installation process was discontinued. This has been fixed.</td>
</tr>
<tr>
<td></td>
<td>RobotStudio allows safety geometries to be defined in a simplified XML file and imported into RobotStudio. Files which could be successfully imported in RobotStudio 6.06.01 failed in 6.07 due to unnecessarily strict validation. This has been changed back in RobotStudio 6.07.01 to allow import again.</td>
</tr>
<tr>
<td>-</td>
<td>Smart component signal names are limited to 32 chars and does not allows dots (&quot;.&quot; )</td>
</tr>
<tr>
<td></td>
<td>Smart component signal names were required to follow the naming restrictions that apply to the IRC5 controller for all signals, even signal that are not connected to a controller. This has been relaxed in RobotStudio 6.07.01 to allow longer signal names and names with dots.</td>
</tr>
</tbody>
</table>

4.2 Corrections made in 6.07

PDDs

<table>
<thead>
<tr>
<th>ID</th>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>3389</td>
<td>Viewing joint movements slows down the simulation</td>
</tr>
<tr>
<td>6767</td>
<td>RobotStudio: program editor intelligence issue</td>
</tr>
<tr>
<td>7685</td>
<td>RobotStudio Docs missing detail on Oculus Rift and HTC Vive</td>
</tr>
<tr>
<td>8218</td>
<td>Incorrect information about how to start and stop tasks.</td>
</tr>
<tr>
<td>8417</td>
<td>Scara Not Available on Full Size Controller</td>
</tr>
<tr>
<td>8597</td>
<td>System from Backup causes exception, if RW Addin is not available -</td>
</tr>
<tr>
<td>9008</td>
<td>Jerky motion during simulation</td>
</tr>
<tr>
<td>9021</td>
<td>IRBT6004 Double CAD Model</td>
</tr>
</tbody>
</table>

© Copyright 2018 ABB All rights reserved
<table>
<thead>
<tr>
<th>Issue</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>9037</td>
<td>Can't warmstart the virtual system</td>
</tr>
<tr>
<td>9252</td>
<td>Add proper error message to CAD converter when file not supported.</td>
</tr>
<tr>
<td>9360</td>
<td>SmartComponent line sensor won't align</td>
</tr>
<tr>
<td>9380</td>
<td>PatMax1-50 array result not present</td>
</tr>
<tr>
<td>9381</td>
<td>Results not displayed in HMI for Patmax [1-50]</td>
</tr>
<tr>
<td>9385</td>
<td>User accounts not possible to edit, when choose Handle write access automatically option</td>
</tr>
<tr>
<td>9457</td>
<td>[allowExecStateRunning] is not mentioned in the manual</td>
</tr>
<tr>
<td>9461</td>
<td>Problem Event log screen are not updated after log on in Robotstudio 6.05.03</td>
</tr>
<tr>
<td>9517</td>
<td>Selecting wrong Robotware while Unpacking</td>
</tr>
<tr>
<td>9543</td>
<td>Add checkbox “Reset virtual controllers (I-start)” in the station Open dialog.</td>
</tr>
<tr>
<td>9552</td>
<td>Objects added when clearing conveyor</td>
</tr>
<tr>
<td>9553</td>
<td>Attached to Axis not showing in Rs 6.06.</td>
</tr>
<tr>
<td>9586</td>
<td>Floor plan are not created in SafemoveReport when the robot position in Robotstudio is not in zero position</td>
</tr>
<tr>
<td>9608</td>
<td>Unable to restore Pack&amp;Go</td>
</tr>
<tr>
<td>9609</td>
<td>Wrong Safemove CRC</td>
</tr>
<tr>
<td>9644</td>
<td>Backup problem</td>
</tr>
<tr>
<td>9646</td>
<td>Unwanted parts in selection</td>
</tr>
<tr>
<td>9648</td>
<td>RAPID editor and RS stuck forever</td>
</tr>
<tr>
<td>9649</td>
<td>Existing directory not found</td>
</tr>
<tr>
<td>9654</td>
<td>Graphic Appearance function does not support multiselection</td>
</tr>
<tr>
<td>9655</td>
<td>Create tooldata from pull-down menu not working OK</td>
</tr>
<tr>
<td>9656</td>
<td>Improvement of user interface while dealing with multiple selection</td>
</tr>
<tr>
<td>9668</td>
<td>RobotStudio Change Options exception should not allow both SafeMove1 and SafeMove2 to be installed in same robot</td>
</tr>
<tr>
<td>9669</td>
<td>RobotStudio Change Options exception</td>
</tr>
<tr>
<td>9673</td>
<td>Description in Signal Analyzer (Online) of “Available signals” is not correct</td>
</tr>
<tr>
<td>9680</td>
<td>System crash when untick PickMaster3 option by Change Options function in Controller Tab</td>
</tr>
<tr>
<td>9748</td>
<td>RobotStudio: Robot won't jump to target</td>
</tr>
<tr>
<td>9753</td>
<td>RS crash</td>
</tr>
<tr>
<td>9762</td>
<td>Pack&amp;Go file with conveyor tracking fails to open</td>
</tr>
<tr>
<td>9763</td>
<td>RS / Visual SafeMove not able to support older safety configuration, if PROFIsafe Only is booted.</td>
</tr>
<tr>
<td>9764</td>
<td>Pbl with axis config of first instruction of a path</td>
</tr>
<tr>
<td>9767</td>
<td>Problem Opening old PnG in RS6.06</td>
</tr>
<tr>
<td>9774</td>
<td>Check Reachability not enabled while opening an ‘old’ station</td>
</tr>
<tr>
<td>9779</td>
<td>Station Viewer crashes in VR</td>
</tr>
<tr>
<td>9784</td>
<td>ROBotStudio 6.06.01 crashes when using PaintApplicator</td>
</tr>
<tr>
<td>9797</td>
<td>RS unexpected failure after open backup file</td>
</tr>
<tr>
<td>9799</td>
<td>TCP trace not working for systems with old RW release</td>
</tr>
<tr>
<td>9852</td>
<td>SafeMove 2/Profisafe issue</td>
</tr>
<tr>
<td>9860</td>
<td>Exception when downloading SafeMove 2 configuration to robot or VC</td>
</tr>
<tr>
<td>9895</td>
<td>Function “Adjust Robtarget” tooldata could not selected when the user in connected to a real controller</td>
</tr>
<tr>
<td>9981</td>
<td>Protected elements checksum changing for no reason</td>
</tr>
</tbody>
</table>
5 Known Limitations

Overview
This section describes known limitations in RobotStudio.

5.1 Visual SafeMove

Protected checksum may change when upgrading RW from 6.04.0x to 6.05 or 6.06
The protected checksum will change if the input and output modules of the internal device is protected. The reason is that two attributes change order.

No visualization of Safe Range for external axes in Visual SafeMove for SafeMove Basic or Pro
When Safe Range is used to limit the axis range of an external axis such as a track motion, there will be no visual indication of the actual range in the graphic view.

Visual SafeMove windows can be re-opened from the Quick Access Toolbar menu
Any windows that are closed can be re-opened using the Quick Access Toolbar menu, as the command Default Layout does not recover these windows.

SafeMove Tool Zone visualization in Online Monitor for robots with external axes
Only TCP robots and track mounted robots will be visualized in the Online Monitor, no other external axes or positioners.
As a consequence, the Online Monitor may show the robot in a non-violating position, even though the safety controller has detected a safety violation and stopped the robot.

5.2 Online

Individual RAPID tasks cannot be stopped for RobotWare 5.60 and later
When running multitasking systems, it is not possible to start and stop individual tasks with the dropdown menu of the task node in the Controller browser. This is due a restriction introduced with RobotWare 5.60 and later.
However, from RobotWare 6.03 onwards, then RAPID tasks to execute or to stop can be selected from RobotStudio RAPID tab.

FlexPendant Viewer running with automatic reloading
When having FlexPendant Viewer running with automatic reloading of the screens and at the same time jogging the robot with the joystick the robot jogging might halt when the FlexPendant Viewer reloads.

5.2.1 Online – Paint

Backup for Paint systems does not create backup of the PIB for IRC5P with RobotWare 5.xx
The Backup function of RobotStudio does not create a backup of the PIB board of the IRC5P system when running RobotWare 5.xx.
Workaround: Create the backup of the PIB board with the FlexPaint Pendant using an USB-stick.

Go Offline does not work for Paint systems
The Go offline function will not create a working Virtual controller system for Paint system unless the Paint package I/O option is set to Simulated.
5.2.2 Online – Integrated Vision

*RobotStudio may hang for up to 60 seconds when configuring jobs with PatMax 1-50

The user interface of RobotStudio may freeze for up to 60 seconds when configuration
Integrated Vision jobs with the tool PatMax 1-50.

**Workaround:** Use PatMax 1-10 instead.

Remaining error – New Emulators

New camera models have been added to the camera emulator option in RobotStudio
6.04.01. Some of these new models are not yet fully compatible. Our recommendation is to
choose a camera model from the 7000 series which is fully compatible with Firmware
version 4.10.2.

Emulated cameras not discovered when controller in Motors On

For RobotWare 5.61 onwards, the camera discovery mechanism is disabled when the
controller is in Motors On. As a consequence, the camera nodes will not appear in the
controller browser.

**Workaround:** Switch to Manual Reduced Speed and use the Refresh command on the
Integrated Vision node in the browser to make the cameras appear.

Information – Integrated Vision only works on 32-bit installations

It is not possible to use Integrated Vision in the 64-bit version of RobotStudio.

Information – Camera firmware version and update

The minimum firmware version to be used with Integrated Vision is 4.08. If this version is not
available for a specific camera model, then the newest version available shall be used.

There are two important things to know before upgrading a sensor

- The user must make sure to first backup the files on the camera. This can be done
  using the Rapid snippets for camera backup/restore, or the FlexPendant Explorer.
- The latest available firmware version may vary across sensor types. However, when
  the firmware update utility presents the latest available version it shows the
  firmware with the highest version number which may not apply to the sensor to be
  updated. However, the appropriate firmware will be applied.

Information – The spreadsheet view

The spreadsheet view is not enabled when editing in the in the following modes “Add part
location tool”, “Add part inspection tool”. Before entering the spreadsheet mode click for
example “Setup Image” or Output to Rapid.

Information – Calibration board without fiducial

When using the calibration boards, checkerboard or board with dots, the user must select
the preferred origin by clicking and accepting (press enter) three points on the board. Only
after these three points have been selected is it possible to click “calibrate” to execute the
 calibration.

Information - Use default camera settings

If the camera is not using default communication settings the result may be that RAPID
instructions return error code “Communication Error”. The safest method to get default
settings is to go to Connect->Add Sensor Right click and select “Show all sensors”. Select
the device to reset and click “Apply factory settings” in the lower right corner. The most
important settings are:
Telnet port: 23
User: “admin”
Password: ““

**Information – User Credentials**

It is now possible to create user profiles with different access levels on the camera. For detailed information about this, please refer to the Integrated Vision User Manual.

**Remaining error – Save image on camera**

It is not possible to save an image on the camera using “Save Image”. This is by design, but the dialog still allows the user to try to do this. The result is that the image is not saved and no error message is given.

**Remaining error - Connect button greyed out for no reason**

It may sometimes happen that the “Connect” button is greyed out, with the tooltip saying the camera is not on the correct subnet although the IP settings are OK.

**Workaround:** Restart the Integrated Vision Add-In.

**Remaining error – VC started from Controller->Add controller does not detect cameras**

A VC that is started from Controller->Add controller does not detect cameras on the network, even if the VC_network_definition.xml is correctly configured and the firewall is turned off. The reason is that the controller is not able to detect new cameras on the network when it is in “Motors On” state. When the VC is started stand-alone in RobotStudio it is automatically set to “Motors On” when started.

**Workaround:** To allow it to discover cameras, turn the control panel key to manual mode or launch the VC as part of a station.

**User tip – Removing cameras from configuration**

To remove a configured camera from the list of configured cameras, use the configuration editor. Enter Configuration->Communication->Application Protocols and remove the desired camera. Perform a warm start to complete the operation.

**User tip – Viewing all cameras present on the network**

Connect->Add Sensor is normally used for setting the IP addresses of sensors that are not currently on the correct subnet (192.168.125.X). Since the dialog shows all cameras “seen” by the PC, this dialog is useful when error tracing camera network problems.

If a camera does not appear on the network using the “Add sensor” dialog as suggested above, it is advisable to cycle the power of the camera. If the camera receives power from the controller, then cycle power by turning the mains switch.

**User tip – Warm start the controller after changing network settings**

Whenever changing the network settings of the camera, either from Connect->Add Sensor or Connect->Network settings, it is important to warm start the controller. If this is not done, RAPID instructions will give the error “Communication Error” and the FTP-mounted camera disk is not accessible. If DHCP address is used and persist, please try a static address instead.
5.3 Offline

*Event “Not allowed command” may be shown in the output window*

When starting a Virtual Controller with RobotWare 5, the evenlog message “Not allowed command” may be displayed in the output window. This message can safely be ignored.

*Live update of Signal Analyzer may cause lag.

When running Signal Analyzer with live update for virtual controllers, the graph rendering may cause lag and slow the simulation down. As a workaround, switch windows back and forth to force an update of the graph rendering of the Signal Analyzer.

The robot IRB 1600ID 1.55 m / 6 kg replaced by IRB 1660ID1.55 m / 6 m in RobotWare 6.04

The robot IRB 1600ID 1.55 m / 6 kg is not available in RobotWare 6.04 and later. It has been renamed to IRB 1660ID 1.55 m / 6 kg. Virtual controller systems for IRB 1600ID 1.55 m / 6 kg based on RobotWare 6.03 cannot upgraded to RobotWare 6.04 and later. This means that Pack&Go files for this robot based on RobotWare 6.03 cannot be upgraded to RobotWare 6.04 automatically

**Workaround:** Re-build or modify the virtual controller system to use IRB 1660ID 1.55 m / 6 kg instead when using RobotWare 6.04 or later.

FlexPendant and RAPID applications run with logged in user rights

A FlexPendant or RAPID application running on the virtual controller runs with the rights of the logged-in Windows user. RAPID applications running in a background task will start to execute when the Pack&Go file is opened and FlexPendant applications will start to execute when the user starts the Virtual FlexPendant.

A warning message has been added to the Unpack&Work wizard to make the user aware that only Pack&Go files (.rspag) from trusted sources shall be opened.

Compatibility of RobotStudio Library and Stations with older RobotStudio versions

RobotStudio is generally not forwards compatible, i.e. it is not possible to load stations or libraries created in RobotStudio 6.04 into an earlier version of RobotStudio such as e.g. RobotStudio 5.x, 6.03.02 or earlier. However, RobotStudio is backwards compatible, which means stations and libraries created in versions 5.x, 6.03.02 or earlier can be opened in RobotStudio 6.04.

TrueMove path visualization fails for customized zone data.

The TrueMove path visualization function only supports predefined zonedata. It will not work for user defined zonedata.
Backup fails for RobotStudio solutions with SafeMove or Electronic Position Switches

Backups are automatically created for virtual controller systems that are part of a RobotStudio solution when saving the station. For virtual controller systems with the RobotWare options SafeMove or Electronic Positioning Switches the backup will fail since these systems contain files that are read-only. As a result, an error message is presented in the output window: "<System name>: Backup failed". The station will be successfully saved but there will be no backup created.

**Workaround:** Ignore the error message "<System name>: Backup failed" and create a manual backup whenever needed. The RobotStudio Option "Enable automatic backup of controllers in solution" that is available in"RobotStudio Options -> Robotics -> Virtual Controller" can be de-selected to disable the backup function.

IRB 14000 cannot be combined with any other robot

The function system from layout fails if trying to create a MultiMove system where one robot is an IRB 14000. The reason is that the IRB 14000 cannot be combined with any other robot.

**Workaround:** Create a separate system for the IRB 14000.

The Work Envelope function does not support IRB 14000

The function is disabled for the IRB 14000 and cannot be activated.

The 2D work envelope fails for certain robot models

As a result, the generated work envelop may appear distorted.

Update of current selection in the 3D graphics window may be delayed

A problem related to the graphics driver has been observed on certain PCs. The problem is that the update of the current selection in the 3D graphics is delayed until the next redraw.

**Workaround:** Add or uncomment the following line in the file RobotStudio.exe.config

```
<add key="DoublePresentWorkaround" value="true" />
```

Failure to open Pack&Go file to same folder the second time

RobotStudio will prevent Pack&Go files to be opened to the same folder a second time if the station contains VC systems with the EPS or SafeMove option. This is by design to prevent the safety controller configuration file to be accidentally overwritten.

**Workaround:** Remove the write protection manually using Windows Explorer.

Updates of instruction template and code snippets

RobotStudio will not automatically update the user files for instruction templates and code snippets files in the folders:

- `\My Documents\RobotStudio\Instruction Templates`
- `\My Documents\RobotStudio\Code snippets`

**Workaround:** The user has to manually copy the latest files from

- `%ProgramFiles%\ABB Industrial IT\Robotics IT\RobotStudio 5.xx\Instruction Templates`,
- and
- `%ProgramFiles%\ABB Industrial IT\Robotics IT\RobotStudio 5.xx\Code Snippets`

to the data folder.
**IO signals configured with access level ‘DEFAULT’**

When IO signals are configured with access level ‘DEFAULT’, only input signals are possible to set/reset from the I/O Simulator and I/O Window. To be able to affect also output signals, set the access level to ‘ALL’ for them in the Configuration Editor.

**VC does not start with RRI option and GSI folder structure missing.**

The VC will hang when started with a system containing the RobotWare option RRI (Robot Reference Interface) if the GSI folder structure is missing.

**Workaround:** create GSI Folder before starting the VC inside the HOME directory of the system. See the Application Manual for Robot Reference interface for more information.

**System in Guard Stop state in Automatic mode after run-time error**

Certain run-time errors may cause the controller system to enter Guard Stop state in Automatic mode. This is the same behavior as in a physical robot controller system. This typically happens when a run-time error related to Conveyor Tracking occurs. A simulation cannot be started when the controller is in this state.

**Workaround:** To reset the controller state, open the Control Panel window and first switch to Manual mode, and then back to Automatic mode.

**Information message starting system with IRB260/460/660/760**

Starting a system with IRB260/660 gives you an error message: ‘The number of joints is different between the library model and the controller configurations’. The reason is that the IRBx60 is modeled with six joints in RobotStudio of which two are locked, but has four joints in the VC.

**Path handling of instructions with multiple joint targets**

The path functions Rotate, Translate, and Mirror do not work as expected with instructions containing via points as jointtargets. The functions will leave the jointtargets as is. Interpolate Path gives an Unknown Error and Tool Compensation reports an error message.

**EventManager: Simulation cannot be triggered by analog system signals**

The event manager only supports analog station signals, not analog system signals.

**Conveyor Tracking**

*Conveyor objects must be re-added for stations created prior to RS 6.05.*

When opening stations with conveyor tracking created prior to RobotStudio 6.05, conveyor objects must be re-added.

**Incorrect default values for c1Position and c1Speed for RobotWare 5 with the PaintWare option**

The default values for the parameters c1Position and c1Speed may become incorrect for a virtual controller system. The symptom is that its attribute values are all zero, see snapshot below.
Workaround: Save the following lines to a CFG file named ‘TEMP.CFG’ or similar and load in the virtual controller followed by a restart.

```
EIO:CFG_1.0:5:0::
#
EIO_SIGNAL:
-Name "c1Position" -SignalType "AI" -Unit "CnvIf"
-SignalLabel "ctPosition" -UnitMap "0-31" -Access "ALL"
-MaxLog 21474.8 -MaxPhys 1 -MaxPhysLimit 1
-MaxBitVal 2147483647 -MinLog -21474.8 -MinPhys -1 -MinPhysLimit -1
-MinBitVal -2147483647
-Name "c1Speed" -SignalType "AI" -Unit "CnvIf" -SignalLabel "ctSpeed"
-UnitMap "32-63" -Access "ALL"
-MaxLog 21474.8 -MaxPhys 1 -MaxPhysLimit 1
-MaxBitVal 2147483647 -MinLog -21474.8 -MinPhys -1 -MinPhysLimit -1
-MinBitVal -2147483647
```

5.3.2 Station Viewer

Memory problem when doing Save As Viewer or Record To Viewer with large stations

RobotStudio may run out of memory (OutOfMemory exception) when doing Save As Viewer or Record To Viewer if the station is very large.

Workaround: Use the 64-bit version of RobotStudio and create a 64-bit viewer by ticking the checkbox in the Save As Viewer file dialog.

5.3.3 MultiMove

MultiMove error: ‘Object reference not set to an instance of an object’

When the Test Play button is pressed in the MultiMove tool, the following error message may be displayed: ‘Object reference not set to an instance of an object’, but the robot moves and the Status ‘Calculation OK’ is displayed. In addition, when ‘Create Paths’ is pressed the following message is displayed: ‘Can’t create paths : Value cannot be null’, and no paths are created. In the ‘Create Paths Settings’, is the WP TCP drop down empty.

Reason: Workobject is not set for the current task
5.3.4 External Axis

**Error 50091: ‘Restart not possible’ after warm start of a system with external axis**

When restarting a system with activated mechanical units the activation state is lost. Then the program can no longer be started from the Virtual FlexPendant, the RAPID Editor or the RAPID Tasks window.

**Workaround:** Reset the program pointer (‘Program Pointer to Main’) before starting the program from the Virtual FlexPendant, the RAPID Editor or the RAPID Tasks window, or, start the program from the Simulation Play button.

5.3.5 Network Drives and UNC Paths

**RobotStudio on computers with roaming user profiles**

RobotStudio may fail on PC configurations with roaming user profiles, i.e. when the users’ documents folder resides on a server and not on the local disk.

**Workaround:** Redefine the ‘User Project Folder’ to a folder on the local disk (File → Options → General → Files&Folders → User Project Folder).

**Virtual Controller does not support UNC paths**

UNC paths cannot be used to locate Virtual Controller systems. Using UNC paths for VC systems will cause the log message ‘Failed to initialize FW upgrade framework’ to appear when the system starts. Subsequent attempts to work with the VC such as synchronizing RAPID data will fail.

**Creating and starting systems located on a network drive**

When using a network drive to store RobotStudio data such as RobotWare systems or the RobotWare mediapool, the following problems may occur

- Virtual controller does not start
- Not possible to open Virtual FlexPendant

**Cause:** By default, the .NET Framework does not allow execution of code from a remote file system. This means the application may behave unexpectedly if the media used by the system or the system itself resides on a network share.

**Workaround:** To resolve this, the user must explicitly grant the required permissions:

1. Open the file Virtual FlexPendant.exe.config located in

   C:\Program Files (x86)\ABB Industrial IT\Robotics IT\RobotStudio 5.61\Bin

2. Add the following lines

   ```xml
   <?xml version="1.0"?>
   <configuration>
   <startup useLegacyV2RuntimeActivationPolicy="true">
   <supportedRuntime version="v4.0" sku=".NETFramework,Version=v4.0"/></startup>
   <runtime>
   <!-- THIS IS ONE OF THE NEW LINES!!! -->
   <loadFromRemoteSources enabled="true"/>
   <!-- THIS IS ONE OF THE NEW LINES!!! -->
   </runtime>
   </configuration>
   ``

The Virtual FlexPendant must be restarted for the changes to take effect.

For further information, see

5.3.6 RAPID

Robtargets that are LOCAL to a PROCEDURE cannot be synchronized with RobotStudio

The RobotStudio synchronization engine that translates 3D data of the station to RAPID code and vice versa does not support robtargets that are declared locally to a procedure.

Workaround: Declare the robtargets as global or local to a module instead.

Robtarget names must be unique in RAPID even if they are LOCAL

RobotStudio requires that robtarget names are unique for the RAPID synchronization to work properly, i.e. you cannot have a global robtarget named pMyTarget1 in module A and a local robtarget with the same name in Module B.

Global robtargets cannot be made local through Synchronization to VC

Global robtargets cannot be changed to local through Synchronization to VC, the option is disabled (PDD 3140).

Workaround: Change the robtargets to module local in the RAPID Editor and Synchronize to station.

Error Message: Sync. to Station completed with errors

Error Message: Sync to Station completed with errors: New data <name> <type> has same name as existing object in same block <routine>.

When this error message appears, there is a storage type mix-up between data already stored in RS and in the VC. Because of this, and per design, the data is not considered the same data.

Workaround: 1. Ensure all data declarations have the same definition in RS as in RAPID (there is no user interface for this).
2. Sync to station should now work.
3. Sync back to controller, and remember to change the data declarations back to what you want.

5.3.7 Paint

The new conveyor tracking module DSQC2000 is not supported for paint robots.

The new conveyor tracking module DSQC2000 is not supported for paint robots.

Lack of Virtual Controller support for the Paint systems

Paint systems that are configured using the Paint package I/O option Discrete, Compact or Fieldbus, will result in a SysFail state.

Workaround: Re-create the system with the simulated I/O option.
5.3.8 Graphics and Geometry

*First character of part name incorrect when importing assemblies or converting files
The first character of part or assembly names may become incorrect when importing CAD parts or assemblies into a RobotStudio station. The error only occurs on Windows 7.

Some CAD converters not available in Premium trial license
No trial license available for CAD converters for DXF/DWG, JT, NX, Parasolid, Solid Edge, and SolidWorks.

Enforce selected graphics device for PCs with multiple graphics cards
For best performance when running RobotStudio on a PC with multiple graphics cards, RobotStudio can be configured to use a specified device. By this option you can ensure maximum performance. This is useful for e.g. Lenovo W540 that has both an integrated Intel graphics device and a discrete NVIDIA card.

Open the file RobotStudio.exe.config that is located in the folders
C:\Program Files (x86)\ABB Industrial IT\Robotics IT\RobotStudio 6.0\Bin64 and
C:\Program Files (x86)\ABB Industrial IT\Robotics IT\RobotStudio 6.0\Bin
and uncomment the line

```
<add key="GraphicsDeviceType" value="Discrete"/>
```

Valid values are 'Discrete', 'Integrated' and 'Warp' (software renderer).

Note that there are two different files, one for the 32-bit version, and another for the 64-bit version.

Problems when undoing Boolean operations on Geometry
Undoing a Boolean operation might not succeed. To recover from these problems, you need to delete the items that caused the problem.

Out of memory
The application might fail when out of memory due to the import of very large ACIS files or load of very large stations.

**Workaround:** Use the 64-bit version that can handle more memory. Ensure that you have enough memory installed on the PC, see System Requirements.

5.4 ScreenMaker Limitations

A ScreenMaker application may fail to build if the DPI setting is not set to 100%
Certain UI controls in ScreenMaker may fail to build correctly if the DPI setting is not set to ‘Smaller – 100%’.

**Symptom:** The error message caused by this problem will read ‘System.Drawing.Font’ does not contain a constructor that takes 2 arguments.

**Workaround:** Set DPI to 100% on your PC.

File changes to FlexPendant applications does not load the changes until a FlexPendant reset
With RobotWare 6.0x the controller’s restart will no longer reset the FlexPendant memory. This was part of an effort to improve the restart time of the controller.
This means that after placing a new FlexPendant application file(s) on the FlexPendant unit, you need to manually reset the FlexPendant for it to reload its assets.

To manually reset the FlexPendant you need to use the reset button on the FlexPendant's backside. (See Operating Manual – IRC5 with FlexPendant, 3HAC16590)

**Dynamic update of Rapid Data**

The switch from Manual Mode to Auto Mode causes the RAPID boolean data bound to the enabled property of control change to value TRUE. This behavior is noticed when the mode is changed from a different screen and not on the screen where the control is bound to RAPID boolean data. An additional side effect is that the enabled property of RunRoutine button has been disabled as similar behavior was seen.

**Running Routine with Movement**

RunRoutine Button control does not always work correct when a routine with movements is called.

As a workaround use instructions like StopMove, StorePath, RestorePath and StartMove to control the movements of the robot.

A Trap routine could be called with a normal button control and in the Trap the above instructions can be used to control the movements of the robot.

**PictureBox control as a Widget**

If a Picture Box control is created as a widget from a Windows 8 operating system, the control is not shown on the FlexPendant. The behavior is fine with any other operating system like Windows 7.
## 6 RobotWare Compatibility

### 6.1 General

**Supported RobotWare versions**

RobotStudio is distributed with the corresponding version of RobotWare and works with RobotWare 5.07 and later. Please check details below.

### 6.2 RobotWare 5.05 and 5.06 Compatibility

RobotWare 5.05 and 5.06 including revisions thereof are not supported by RobotStudio 5.15 and later versions. Please use the corresponding version of RobotStudio for managing robot controllers with any of these RobotWare versions.

### 6.3 RobotWare 5.07 Compatibility

RobotWare 5.07 and its revisions of are supported with the following limitations:

**General**

The location of the program pointer is not updated in the RAPID Editor during program execution.

**Offline**

A limitation in the versions 5.07.02, 5.07.03, and 5.07.04 of RobotWare may cause the Virtual Controller to System Failure state during I-start on certain computers. The problem is due to the ctrl.bin-file not being correctly created.

**Workaround:** Create an empty ctrl.bin file in the INTERNAL folder of the controller system, and then perform a warm start.

<table>
<thead>
<tr>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>The problem will reappear if the system is I-started.</td>
</tr>
</tbody>
</table>

The virtual controller does not support RobotWare 5.07.08 and RobotWare 5.07.07.

**Online**

FlexPendant Viewer does not work RobotWare 5.07

### 6.4 RobotWare 5.08 Compatibility

RobotWare 5.08 and its revisions of are supported with the following limitations:

**Offline**

RobotWare 5.08 is not supported.

**Workaround:** Use RobotWare 5.08.01 or later.

### 6.5 RobotWare 5.10 Compatibility

RobotWare 5.10 and its revisions of are supported with the following limitations:

**Offline**

Starting a controller will generate internal UAS error in controller error log.

### 6.6 RobotWare 5.11 Compatibility

RobotWare 5.11 and its revisions of are supported with the following limitations:
Offline

Linear jogging of a robot across joint values that will cause a change of confdata may fail. For example, if the robot is jogged linearly when joint values is passing 90 degrees for axis 1 may cause the robot to stop or to change configuration.

6.7 RobotWare 5.12 Compatibility

RobotWare 5.12 and its revisions of are supported with the following limitations:

Paint backups from RW 5.12.01 not compatible with RW 5.12.02 or later

Restoring a paint system backup from RobotWare 5.12.01 will cause SysFail for RobotWare 5.12.02 or later

Workaround: Add the following parameters to the configuration files

**EIO.CFG**:

```
EIO_SIGNAL:
  - Name "doMainInMC" - SignalType "DO" - Unit "SysComm" - UnitMap "44"
  - Name "ALHEEnRo" - SignalType "GO" - Unit "SysComm" - UnitMap "150-151"
  - Access "ALL"
  - Name "ALHVEn" - SignalType "DO" - Unit "SysComm" - UnitMap "155"
  - Access "ALL"
```

**EIO_CROSS**:

```
  - Res "ALHVEn" - Act1 "HVEnabled"
```

**SYS.CFG**:

```
CAB_TASK_MODULES:
  - File "INTERNAL:/pntrapid/T_ROB1/cycinfo.sys" - ModName "cycinfo"
  - Task "T_ROB1"
  - File "INTERNAL:/pntrapid/csvlkup.sys" - ModName "csvlkup" - AllTask
  - Hidden
```

6.8 RobotWare 5.13 Compatibility

RobotWare 5.13 and its revisions of are supported with the following limitations:

Paint backups from RW 5.12.02, 5.12.03 or RW 5.13 or 5.13.01 not compatible with RW 5.13.02 or RW 5.13.03

There are several changes in the configuration database for I/O (EIO.CFG) and Controller (SYS.CFG) that will cause System Failure if an old backup is loaded. There are also changed in installed RAPID modules. To create a compatible configuration, proceed as follows:

1. Create and start a VC with a RobotWare 5.13.03 system containing the same options as your original backup, but do not load the backup.
2. Save the EIO.CFG and SYS.CFG to file.
3. Compare the saved files with the corresponding files of your backup. (You can use a text file comparison tool for simplification.)
4. Add your system-specific configuration to the general configuration files saved from the 5.13.01-system using a text editor.
5. Replace the files of the original backup with the corresponding modified configuration files.
6. Go through the RAPID modules of the backup and remove the default modules (i.e. those that are not changed by the user).
7. Load the backup and restart the system. You are done.
6.9 RobotWare 5.15 Compatibility

Signal Analyzer Online

The feature Signal Analyzer Online requires RobotWare 5.15.03 or later.

6.10 RobotWare 6 Compatibility

Overview

RobotWare 6.00 and 6.00.01 systems cannot be directly upgraded to RobotWare 6.01. To upgrade a system, you need to create backup and migrate it using the tool 'Migrate Backup or Folder', then recreate the system and finally, restore the backup.

For this reason, the functions ‘Unpack&Work’, ‘Go Offline’ and ‘New Solution with Station and Robot Controller – From backup’ are blocked to prevent upgrade from RobotWare 6.00 or 6.00.01 to RobotWare 6.01.

RobotStudio, however, is compatible with both RobotWare 6.00 / 6.00.01 and 6.01.

6.11 General Compatibility Limitations

Safety Configuration

Safety configuration of a track motion IRC5 system equipped with a safety controller of type EPS or SafeMove can be done without the need to read track motion parameters manually when using RobotWare 5.11.01 or later. Encrypted parameters needed by the safety controller will be automatically read by EPS Wizard and SafeMove Configurator, respectively.

Configurations

The feature Configurations for selecting the robot arm configuration (confdata) may fail, or not present all solutions, in some specific circumstances even when the target is reachable if RobotWare 5.14 or earlier is used.

Workaround: Upgrade to RW5.14.01 or later

6.12 ScreenMaker Compatibility

RobotWare

It is possible to use previous RobotWare versions, but with some limitations.

- ActionTrigger will work only on RobotWare 5.12.02 or later.
- The controls Button, TpsLabel and PictureBox controls was modified in RobotStudio 5.13. The property 'Allow MultipleStates' of these controls can be accessed from RobotWare 5.13 and later.
- Variant Button will work only on RobotWare 5.14.01 or later
- Conditional Trigger will work only on RobotWare 5.14.01 or later
- Widgets will work only on RobotWare 5.60 or later.

FlexPendant SDK

ScreenMaker should be used with FlexPendant SDK 5.12.02 or later. ScreenMaker allows selection of FlexPendant SDK version when it is launched. If only one version of FlexPendant SDK is available in the system, it is loaded by default.
6.13 Support for future RobotWare versions

RobotStudio 6.07 supports all future minor revisions of RobotWare 6.07, but no future major releases. For example, RobotStudio 6.07 will support RobotWare 6.07.01 (if, and when available) but not RobotWare 6.08 or later.